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9.1.

Theme numeéero 9

Points essentiels traités dans ce theme :

Révision sur les listes

Tri d’une liste sur plus de trois criteres

Génération d’un tableau croisé dynamique (utilisé pour le theme
10)

Création d’une liste

Ouvrez EXCEL
Saisissez dans les cellules Al, B1, C1, D1 et E1 les libellés
suivants :

A B C D E

1

Région Département Représentant Produit Ventes

Pour élargir toutes les colonnes A a E dans une méme proportion :
o Sélectionnez I’ensemble de ces colonnes
o Saisissez le trait de séparation entre la case grisée qui contient
la désignation de la colonne E et celle qui contient la
désignation de la colonne F, en y placant le curseur de souris,
qui prend la forme de deux fleches dos a dos séparées par un
trait vertical <>
o «emmenez » le trait de séparation vers la droite, en
maintenant enfoncé le bouton gauche de la souris
o relachez le bouton de la souris lorsque vous serez satisfait de
I’emplacement du trait de séparation.
Sélectionnez le bloc A1:E1.
Centrez ces libellés, grace a la rubrique
Accueil=>Alignement->[=], onglet Alignement de la boite de
dialogue Format de cellule, cadre Horizontal, choix Centre.
( Home=>Alignment—=>[-2], ...,Center en anglais)
Validez ce centrage en utilisant la touche [Entrée] ou le bouton
Ok
Laissez sélectionné le bloc Al :E1.
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e Activez la rubrique Formulaire de la barre d’outils d’acces
rapide (si elle n’apparait pas, reportez-vous aux instructions du

Séance 5 — 2°™ partie

début du Theme 8 pour la faire apparaitre).

e Acceptez le choix de la premiére ligne pour les en-tétes de
colonnes, par [Entrée] ou en cliguant sur le bouton

e Saisissez les données suivantes :

Ok

A B C D E
1 Region [Département |[Représentant |Produit Ventes
2 |IDF 95|Fourgassie camembert 5000
3 |IDF 94 (Espenant chips 6500
4 |IDF 91|Bernier gruyéere 7000
5 IDF 75|Andrieu camembert 7800
6 PACA 13|Guilhem anchois 7825
7 PACA 84|Hourdin olives 7875
8 IDF 94|Espenant gruyéere 8000
9 IDF 91|Bernier chips 8500
10 | IDF 753(Andrieu chips 8541
11 | IDF 95|Fourgassie saucisson 11800
12 |IDF 92|Choblet saucisson 12350
13 |IDF 93| Delforge jambon 12800
14 PACA 13|Guilhem brandade 12875
15 | IDF 95|Fourgassie jambon 14500
16 PACA g4(Capelle brandade 15000
17 IDF 91|Bernier jambon 15200
18 [IDF 75|Andrieu saucisson 153330
19 IDF 753(Andrieu jambon 18500

Remarque : il est plus aisé de saisir une telle liste directement. Ne
perdez pas trop de temps avec la grille de saisie. (Dés que vous aurez
introduit quelques caracteres dans une case, EXCEL vous proposera
automatiguement le texte commencant par ces caracteres et situé dans

la méme colonne, vous n’aurez alors qu’a I’accepter)

Madame Véronique HEIWY

L’usage de cette brochure est réservé exclusivement aux travaux dirigés de I’Université PARIS 1, UFR

Gestion-Sorbonne, L2




Excel Séance 5 — 2°™ partie

9.2.

Tri de la liste sur plus de trois

criteres

Quand on déesire réaliser un tri sur plus de trois criteres, on commence
par trier sur les criteres mineurs.

Sélectionnez les colonnes A a E. Deux techniques sont possibles :

o Cliquez pres du A, puis maintenez enfoncé le bouton de la souris
et déplacez celle-ci vers la droite pour étendre la sélection
jusqu’a la colonne E. Reléchez ensuite le bouton.

o Cliquez pres du A, puis cliquez prés du E en maintenant
enfonceée la touche [Majuscule].

Activez la rubrique de menu Données>Trier & Filtrer->Trier
( Data=>Sort & Filter->Sort).

Sélectionnez comme premiére clé la colonne Produit, et comme
sens de tri Croissant ( Ascending ).

Assurez-vous que les deux autres clés de tri sont bien vides, sinon
sélectionnez aucune ( None )dans la boite de choix correspondante.

Validez par [Entrée] ou en cliquant sur le bouton [OKk..

EXCEL réalise un tri par produit. Vous pouvez verifier que les
produits sont classés par ordre alphabétique, d’anchois a saucisson.

Activez a nouveau la rubrique de menu Données—>Trier & Filtrer
2> Trier.

Sélectionnez comme premiere clé la colonne Région, et comme
sens de tri Croissant.

Sélectionnez comme seconde clé la colonne Département, et
comme sens de tri Croissant.

Sélectionnez comme troisieme clé la colonne Représentant, et
comme sens de tri Croissant.

Sélectionnez comme quatrieme clé la colonne Ventes, et comme
sens de tri décroissant.
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e Validez par [Entrée] ou en cliquant sur le bouton [OK.

Le tableau se trouve a présent trié par ordre croissant sur région,
puis sur departement, puis sur représentant, enfin par ordre

décroissant sur ventes. Voici ce que vous devriez obtenir :

A B C D E
1 Région |[Département |Représentant |Produit Ventes
2 IDF 75|Andrieu jambon 18500
3 |IDF 75|Andrieu saucisson 15350
4 |IDF 75(Andrieu chips 8541
5 |IDF 75|Andrieu camembert| 7300
&6 |IDF 91|Bernier jambon 15200
7 |IDF 91|Bernier chips 8500
g |IDF 91(Bernier gruyere 7000
5 IDF 52|Choblet saucisson 12350
10 IDF 33 (Delforge jambon 12800
11 IDF 94|Espenant gruyere a000
12 IDF 94|Espenant chips 6300
13 IDF 95|Fourgassie jambon 14500
14 IDF 95|Fourgassie saucisson 11800
15 IDF 95|Fourgassie camembert 5000
16 PACA 13|Guilhem brandade 12875
17 PACA 13|Guilhem anchois 7825
18 PACA gd(Capelle brandade 15000
19 PACA 84|Hourdin olives 7875

Si vous constatez dans ce tri des anomalies, c’est sans doute parce
que vous n’avez pas orthographié les noms de représentants, de
régions ou de produits de maniére homogene. Rectifiez, puis
recommencez le tri.
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9.3. Création d’un tableau croisé

e Activez la rubriqgue Insertion>Tableaux->{Tableau croisé
dynamique}=> Tableau croisé dynamique (Insert->Tables—>
{Pivot table} =>Pivot table en anglais)

e [’assistant Tableau croisé dynamique affiche sa premiere boite de
dialogue.

excel2019-Theme9.xlsx - Excel

Fichier Accueil Insertion Mise en page Formules Données Révision Affichage Développeur Aide Q Dites-nous ce que vous voulez fai
0y
lllustrations Graphique croisé
- dynamique ~
Tableaux Compléments Graphiques Présenta... Graphiques spar
E19 M f 7875
A B C D E F G H | J K L M N

1 |Région Département Représentant Produit Ventes

2 |IDF 75 Andrieu jambon 18500

3 [IDF 75 Andrieu saucisson 15350

2 |IDF 75| Andrieu chips 8541 Créer un tableau croisé dynamicue ? X

5 [IDF 75 Andrieu camembert 7800 . L

s [iDF 91 Bernier jambon 15200 Choisissez les données a analyser

7 |IDF 91 Bernier chips 8500 (®) Sélectianner un tableau ou une plage

8 |IDF 91 Bernier gruyére 7000 p . Py
5 |IbE 97 Choblet saucisson 12350 Tableau/Plage : | filtrageAvancé!$AST:$E$19 i
10 | IDF 93 Delforge Jjambon 12800 O Utiliser une source de données externes

11 |IDF 94 Espenant gruyére 8000 - )

12 |IDF 94 Espenant chips 6500 Choisir la connexion...

13 |IDF 95 Fourgassie  jambon 14500 Nom de la connexion :

14lbs B Fuurgass!e saucisson LY Utiliser le modéle de données de ce classeur

15 | IDF 95 Fourgassie camembert 5000

16 |PACA 13 Guilhem brandade 12875 Choisissez I'emplacement de votre rapport de tableau croisé dynamique

17 |PACA 13 Guilhem anchois 7825 n

O Nouvelle feuille de calcul

18 |PACA 84 Capelle brandade 15000 )

19 |BAER 84 Hourdin___ olives 7875 ®feuille de calcul existante

20 Emplacement : +
21

22 Indiquez si vous souhaitez analyser plusieurs tables

23

24 D Ajouter ces données au modéle de données

26

27

V4 - V4 \

e Preécisez la plage de cellules contenant les données a analyser

entétes de colonnes comprises (Al :E19) et ’emplacement du
tableau croisé dynamique (cochez « Nouvelle feuille de calcul » ou
une « feuille de calcul existante » mais vide).

Madame Véronique HEIWY
L’usage de cette brochure est réservé exclusivement aux travaux dirigés de I’Université PARIS 1, UFR
Gestion-Sorbonne, L2



Excel Séance 5 — 2°™ partie

Créer un tableau croisé dynamique ? X

Choisissez les données & analyser

(®) Sélectionner un tableau ou une plage

¥

Tableau/Plage: filtrageAvancé!$A$1:$E$19
O Utiliser une source de données externes
Choisir la connexion...
Nom de la connexion :

Utiliser le modéle de données de ce classeur

O Eeuille de calcul existante

¥

Emplacement :

Indiquez si vous souhaitez analyser plusieurs tables

I:‘ Ajouter ces données au modéle de données

e cliguez sur le bouton |OK|.

L’assistant affiche sa deuxieme boite de dialogue. Cette boite a pour
objet de réaliser le tableau croisé dynamique.
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H ©- = excel2019-Theme9.xlsx - Excel

Fichier ~Accuei|Inserti | Mise e Formu| Donn¢| Révisic| Affich:| Dévelc| Aide lAREWEE] Création Q Dites-le-r ‘:_i_ Partager

Fameﬁ[gpﬂ%a

Options du tableau Champ Groupe Filtrer Actualiser Changer la source Actions Calculs Outils Afficher

croisé dynamique ~ actif - = o - de données ~ v M M M
Données A
A3 s Jfr v
A B C D ~ 02

; Champs de tableau croisé.. ¥ %
2 | Choisissez les champs & inclure dans le rapport : %~
3
4 | . — . Rechercher o)
| | Tableau croisé dynamiquel

3 ., O Région -
6 | Pour générer un rapport, choisissez i

) ] Département
7 des champs dans la liste des champs
. . D Représentant
8 | de tableau croisé dynamique
9 [ Produit M
10 Faites glisser les champs dans les zones voulues
11 EE==a ci-dessous:
12 ===
13 S O Y Filtres Ill" Colonnes
14 T
15 | ] —
16 |
17
18: = Lignes 2 Valeurs
19
20
21 |
22 | -
) Feuil1 @ p N Différer la mise & jour de la dispositi...

prét 95 A 0 - 1 + 100 %

e Cochez tous les champs et veérifiez que « région », « département »
« représentant » apparaissent bien dans cet ordre! dans la zone
« lignes » ; que « produit » apparait dans la zone « colonnes » et
que « Ventes » apparait dans « Valeurs » sous le forme « Somme
de Ventes ».

1 L’ordre est a respecter car il y a une relation d’inclusion de « représentant » dans « département » et de « département » dans « région ».
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excel2019-Theme xlsx - Excel

ccuel ertion lise en page Formules Données Révision

Options du tableay CMmMe deVentes o endre dans Monter dans la —— Groupe.
croisé dynamique - i@ Parameétres de champs = - de données = s dynamique croisés dynamiques

Champ actif Filtrer Données Outils ~
A3 = i Somme de Ventes
A c D E F G | H ) K L M~ .

1 Champs de tableau croisé.. ~ %
2
S[Somme devame | |Eiiguetins da cotonnes - Choisissez les champs & inclure dans le rapport :
4 Etiquettes de lignes - anchols brandade camembert chips gruyére jambon olives saucisson Total général +
5 =IDF 12800 23541 15000 61000 39500 151841
6 s 7800 B541 18500 15350 50191 1] Hepresentant

Andrieu 7800 8541 18500 15350 50191 [7] Produit
8 1 8500 7000 15200 30700 [ Ventes
a Bernier BS00 7000 15200 30700
B0 =92 12850 12350 Plus de tableaux
1 Choblet 12350 12350
12| ass 12800 12800 Faites glisser les champs dans les zanes voulues
13 Delforge 12800 12800 d:tessous
14 So4 6500 8000 14500 " o
15 Espenant 6500  B0OO 14500
16 =95 5000 14500 11800 31300 Erocii
17 Fourgassie 5000 14500 11800 31300
18 =PACA 7825 27875 7875 43575
19 =1 7825 12875 20700
20 Guilhem 7825 12875 20700 i
21 =84 15000 7875 22875 Someme d
22 Capelle 15000 15000
23 Hourdin 7875 7875
24 Total général 7825 27875 12800 23541 15000 61000 7875 39500 195416
25

Feuil1 | filtrageAvance a dlisy
[ 1

On obtient ainsi le résultat ci-dessus.

La somme des ventes est calculée en croisant produits et régions ;
produits et départements et enfin produits et représentants.

Des sous totaux sont calculés a I’intérieur du tableau.

La colonne « Total général » (colonne J) montre la somme des ventes
par régions, par département et par représentant tous produits
confondus.

La ligne « Total général » (ligne 24) montre la somme des ventes
toutes régions confondues, mais pour chaque produit (en anglais les
totaux généraux sont etiquetés Grand Total. ).

e Si ce n’est pas une « somme » que vous voulez utiliser comme
opération pour résumer vos données :

e cliquez sur « Somme de Ventes »

e choisissez dans le menu contextuel « Parametre des champs de
valeurs »

e Choisissez I’opérateur qui convient dans la boite de dialogue qui
s’affiche :
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Nom de la source: Ventes

données du champ sélectionné

Paramétres des champs de valeurs

Mom personnalisé : | Somme de Ventes

Résumer le champ de valeur par

Synthése des valeurs par  Afficher les valeurs

Choisissez le type de calcul que vous souhaitez utiliser pour résumer

Format de nombre

AnnUIer

Moyenne, Min, Max, Nombre, etc.

e Validez votre choix en cliquant sur OK.

e Si vous avez deja ferme la fenétre de I’assistant de création du
vous pouvez encore faire des
modifications en utilisant le menu «outils de tableau croisé
dynamique » qui apparait dans le ruban lorsque vous cliquez dans

tableau croisé dynamiqu

le tableau croisé dynamique

€,

e Il est composé des deux onglets « Analyse » et « Création »

présentés ci-dessous :

excel2019-ThemeS.dsx -

Formules Données

Excel

ision  Affichage

e de Vi
ot T e Somme de Ventes

croisé dynamique - 1@ Paramétres de champs

A3 - Ji Somme de Ventes

Champ actif : 5 B Insérer un segmen

3 (B8 ?

nger la source Actions Calculs Graphique croisé Suggestions de tableaux Afficher

dynamique croisés dynamiques

g
d
Jonnées Outils -l

B Ol s
Liste de Boutons En-tétes

M -
Champs de tableg famps=+/-"dechamp
Afficher

Il est possible de masquer ou d’afficher les détails du tableau :

¢ en cliquant sur les boutons

ou

+

placés devant « un nom de

région » ou «un numéro de département », vous masquez ou
affichez les détails de ce departement ou de cette région.

e En double-cliguant a nouveau sur «le nom de région » ou «le
numéro de département », vous rétablissez 1’affichage des détails.
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Si vous double-cliguez sur un nom de représentant (dernier niveau

de

détail pour les lignes), EXCEL vous demande selon quel nouveau
critere vous deésirez creer de nouvelles lignes de détail. Une petite

boite de dialogue vous donne le choix entre Produit| et [Ventes|.

e Si vous choisissez |Produit,, tout se passe comme si, lors de la

création du tableau croise, vous aviez fait glisser le bouton Produit
dans la zone Lignes au lieu de le faire glisser dans la zone
Colonnes. Les colonnes correspondant aux différents produits
disparaissent, et il apparait une colonne étiquetée |Produit. Le
tableau croisé devient une réplique de votre liste, avec des sous-
totaux. (Pour obtenir cet effet pour tous les représentants, il faut
double-cliquer sur leurs noms, pour «ouvrir» les listes.) Vous
pouvez revenir a la situation précédente en faisant glisser la cellule
marquée Produits au-dessus de la colonne Total.

Si vous choisissez Ventes|, il apparait autant de lignes de détail
pour chaque représentant que celui-ci a vendu de produits. Il
apparait une colonne Ventes, qui affiche le montant de chaque
vente. Dans chacune de ces lignes de détail, une seule colonne est
garnie, celle qui correspond au produit (ainsi, bien sdr, que la
colonne de total, qui reproduit le montant de la vente de la ligne. En
double-cliquant a nouveau sur le nom du représentant, les lignes de
détail disparaissent, et la colonne Ventes n’affiche plus rien , mais
elle subsiste. Pour la faire disparaitre :

o Activez la rubrique Outils de tableau croisé dynamique
-> Analyse->afficher/masquer->liste des champs

o Faites glisser I’en-téte de colonne, marqué Ventes, dans la
zone des boutons de champs qui conviennent.

Vous pouvez a présent explorer toutes les possibilités de masquage

des détails. A la fin de ce théme, sauvegardez votre classeur,
servira pour le theme 10.

Madame Véronique HEIWY
L’usage de cette brochure est réservé exclusivement aux travaux dirigés de I’Université PARIS 1, UFR
Gestion-Sorbonne, L2



